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This chapter includes: 
• Electrical Safety ....................................................................................................................................................................... 8 
• Operational Safety ................................................................................................................................................................. 9 
• Maintenance Safety ........................................................................................................................................................... 11 
• Printer Symbols ..................................................................................................................................................................... 12 

Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
Xerox® printer. 
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Electrical Safety 

General Guidelines 
 

 WARNINGS:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electrical shock. 

• Do not remove the covers or guards that are fastened with screws unless you are 
installing optional equipment and are instructed to do so. Turn off the printer when 
performing these installations. Disconnect the power cord when removing covers and 
guards for installing optional equipment. Except for user-installable options, there are 
no parts that you can maintain or service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Turn off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
 

Laser Safety 

This printer complies with laser product performance standards set by governmental, national, and 
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous 
light because the beam is totally enclosed during all modes of customer operation and maintenance. 
 

 WARNING: Use of controls, adjustments, or performance of procedures other than those specified in 
this manual can result in hazardous radiation exposure. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of 
your printer. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

Printer Location 
• Place the printer on a level, solid non-vibrating surface with adequate strength to hold the weight of 

the printer. The base printer weight without any packaging materials is approximately 19.2 kg 
(42.2 lb.). 

• Do not block or cover the slots or openings on the printer. These openings are provided for 
ventilation and to prevent overheating of the printer. 

• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air 

conditioning system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
 

Operational Guidelines 
• Do not remove the paper source tray that you selected in either the print driver or control panel while 

the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer when it is printing. 
• Keep hands, hair, neckties, and so on away from the exit and feed rollers. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=environmentna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=environmenteu&Language=English�
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• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 
the protective covers. 

 

Power Cord 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Make sure that each end of 

the cord is securely connected. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is properly grounded. 
Electrical products can be hazardous if misused. 

 

• Only use an extension cord or power strip designed to handle the electrical current capacity of 
the printer. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Replace the power cord if it becomes frayed or worn. 
• Do not unplug or plug the power cord while the printer is turned on. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to 
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

• Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 

• Do not use aerosol cleaners. Clean with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 

recycling programs, go to www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=recyclesupplies&Language=English%20%20�


Safety 

 

12 Phaser 6700 Color Printer 
 User Guide 
 

Printer Symbols 

Symbol Description 

 

Warning or Caution: 
Ignoring this warning could cause serious injury or even death. 
Ignoring this caution could cause injury or damage to the property. 

 

Do not burn the waste cartridge. 

 

Do not burn the item. 

 

Do not expose the imaging unit to light for more than 10 minutes. 

 

Do not touch the imaging unit. 
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This chapter includes: 
• Parts of the Printer............................................................................................................................................................... 14 
• Information Pages .............................................................................................................................................................. 18 
• Energy Saver Mode ............................................................................................................................................................. 19 
• Administration Features ................................................................................................................................................... 20 
• More Information ................................................................................................................................................................ 22 
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Parts of the Printer 

This section includes: 
• Front View ............................................................................................................................................................................... 14 
• Right View ............................................................................................................................................................................... 15 
• Rear View ................................................................................................................................................................................. 15 
• Control Panel.......................................................................................................................................................................... 16 
• Internal Components ......................................................................................................................................................... 16 
• Maintenance Kit ................................................................................................................................................................... 17 
• Finisher ..................................................................................................................................................................................... 17 
 
 

Front View 

 
1. Control Panel 
2. Output Tray 
3. Tray 1 
4. Power Switch 
5. Front Door 
6. Tray 2 

7. Optional 550-Sheet Feeders (Trays 3 and 4) 
8. Optional 1100-Sheet High-Capacity Feeder (Trays 5 and 6) 
9. Front Door Handles 
10. Waste Cartridge 
11. Imaging Unit Door 
12. Toner Cartridges 

 

Note: The printer allows for a maximum of six trays. 
 

The following tray configurations are available: 
• Trays 1 and 2 
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• Trays 1 and 2 plus one 550-Sheet Feeder 
• Trays 1 and 2 plus two 550-Sheet Feeders 
• Trays 1 and 2 plus one 1100-Sheet High-Capacity Feeder 
• Trays 1 and 2 plus one 550-Sheet Feeder and one 1100-Sheet High-Capacity Feeder 
• Trays 1 and 2 plus two 550-Sheet Feeders and one 1100-Sheet High-Capacity Feeder 
 

Note: These are the only supported configurations. 

 
 

Right View 

 
1. Right Side Door 
2. Right Side Door Latch 

3. Tray 1 
4. Trays 3–6 Right Side Doors 

 
 

Rear View 
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1. Control Board 
2. Power Connector for Finisher 
3. Power Connector for Printer 
4. Reset Button for Ground Fault Interrupter (GFI) 
5. Control Board Cover 

6. Test Print Button 
7. USB Connection 
8. USB Memory Port (for service only) 
9. Ethernet Connection 

 
 

Control Panel 

The control panel consists of a touch screen and buttons you press to control the functions available on 
the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print features. 
• Provides access to reference materials. 
• Provides access to Tools and Setup menus. 
• Provides access to Troubleshooting menus and videos. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
• Plays event-driven videos. 

 
1. Touch Screen displays information and provides access to printer functions. 
2. Power Saver enters Sleep mode, and exits Low Power or Sleep mode. 
3. Pause temporarily stops the current print job, allowing you to cancel or resume the job. 
 

Internal Components 
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1. Cleaning Rod 
2. Imaging Unit Door 
3. Imaging Units 
4. Fuser 

5. Transfer Belt 
6. Transfer Roller 
7. Duplex Unit 

 

Note: The Transfer Belt and Transfer Roller are part of the Maintenance Kit. 
  
 

Maintenance Kit 

 
 

1. Transfer Belt 
2. Transfer Roller 

3. Feed Rollers 
4. Feed Roller Cartridge 

 
 

Finisher 

 
1. Finisher Front Door 
2. Finisher Output Tray 
3. Envelope Lever 

4. Horizontal Transport Unit 
5. Paper Advance Knob 
6. Staple Cartridge 

 

Note: Turn the Paper Advance Knob to clear jammed paper from the Finisher paper path. 
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Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 

To print information pages from the control panel: 
1. At the control panel, touch Printer. 
2. On the Information tab, touch Print Reference Materials. 
3. Touch # to set the quantity. 
4. Use the keypad or touch + or - to select the number of copies to print. 
5. Touch OK. 
6. Use the Up or Down Arrow to scroll through the list as needed, and touch the page you want to print. 
7. Touch Print. 
 

Note: Information pages can also be printed from CentreWare Internet Services. 
 

To specify the source tray for printing the information pages: 
1. At the control panel, touch Printer. 
2. Touch the Tools tab, then touch Tray Management. 
3. Touch Information Pages Source. 
4. Touch the specific tray you want the printer to use, or touch Automatic. 
5. Touch OK to confirm the setting. 
6. Touch Back to return to the Tools tab, or touch Home to return to the main screen. 
 

Notes: 

• To print pages that can help you with print quality problems, see Using the Integrated 
Troubleshooting Tools on page 139. 

• Some of the control panel screens contain links to frequently used information pages. 
 
 

Printing the Configuration Report 
1. At the control panel, touch Printer. 
2. On the Information tab, touch Print Reference Materials. 
3. Touch Configuration Report. 
4. Touch Print. 
 

Note: By default, the Configuration Report prints each time the printer is turned on. To turn off this 
setting, select Printer > Tools > Setup > General Settings > Startup Page > Off. 
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Energy Saver Mode 

You can set the time the printer spends idle in ready mode before the printer automatically transitions to 
a lower power level. You can also turn off the automatic transition. 
1. At the control panel, touch Printer. 
2. Touch the Tools tab, then touch Setup. 
3. Touch Energy Saver. 
4. Enable the automatic transition: 

a. Select the Enable Energy Saver check box. 
b. Touch Edit for the option you want to change: 

• Ready Mode to Low Power 
• Low Power to Sleep 

c. Use the keypad to enter the minutes, 1–120. The Low Power default setting is 15. The Sleep 
default setting is 45. 

d. To confirm the change, touch OK, or X to cancel it. 
5. Touch OK to return to the Setup screen. 
 

Notes: 

• To turn off the automatic transition, clear the Enable Energy Saver check box. 
• The printer exits Energy Saver mode when it receives a print job, or when you press the Power 

Saver button. 
 

 



Features 

 

20 Phaser 6700 Color Printer 
 User Guide 
 

Administration Features 

This section includes: 
• CentreWare Internet Services......................................................................................................................................... 20 
• Automatic Data Collection .............................................................................................................................................. 21 
• Billing and Usage Information ....................................................................................................................................... 21 

For details, see the System Administrator Guide at www.xerox.com/office/6700docs. 
 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a 
Web browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, or 

UNIX environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 
 

Accessing CentreWare Internet Services 

At your computer, open a Web browser, type the IP address of the printer in the address field, then press 
Enter or Return.  
 

Finding the IP Address of the Printer 

You can view the IP address of your printer on the control panel or on the Configuration Report. For 
details, see Printing the Configuration Report on page 18. 

To view the IP address on the control panel: 
1. At the control panel, touch Printer. 
2. On the Information tab, touch About This Printer. 
3. Touch the Network tab. 

The IP address appears under TCP/IP (v4). 
If IPv6 is set up, touch TCP/IP (v6) to view details. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=userdocpdfs&FileName=sys_admin_guide&Language=English�


Features 

 

 Phaser 6700 Color Printer 21 
 User Guide 
 

4. To return to the main screen, touch Home. 
 

Note: The IP address can also appear in the upper right or left corner of the main screen. To set this 
up in CentreWare Internet Services, click Properties > General Setup > Control Panel Home Screen. 
For details, see the Help in CentreWare Internet Services. 

 
 

Automatic Data Collection 

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a designated 
servicer uses this data to support and service the printer, or for billing, supplies replenishment, or product 
improvement. Automatically transmitted data can include product registration, meter read, supply level, 
printer configuration and settings, software version, and problem or fault code data. Xerox cannot read, 
view, or download the content of your documents residing on or passing through your printer or any of 
your information management systems. 

To turn off automatic data collection: 

On the Welcome page in CentreWare Internet Services, click the link in the note regarding 
automated services. 
 

Billing and Usage Information 

Billing and printer usage information appears on the Billing Meters information screen. The impression 
counts shown are used for billing. For details on viewing this information, see Billing and Usage 
Information on page 103. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with printer 

Quick Use Guide Packaged with printer 

System Administrator Guide www.xerox.com/office/6700docs  

Video Tutorials Available on the printer control panel and at 
www.xerox.com/office/6700docs  

Recommended Media List United States: www.xerox.com/paper  
Europe: www.xerox.com/europaper  

PhaserSMART Technical Support automatically 
diagnoses problems on your network printer and 
proposes solutions. 

www.phasersmart.com  

Technical support information for your printer includes 
online Technical Support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/6700support  

Information about menus or error messages Control panel Help (?) button 

Information pages Print from the control panel menu 

Order supplies for your printer www.xerox.com/office/6700supplies  

A resource for tools and information, such as interactive 
tutorials, printing templates, helpful tips, and customized 
features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
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This chapter includes: 
• Installation and Setup Overview ................................................................................................................................... 24 
• Modifying General Settings ............................................................................................................................................. 25 
• Installing the Software ...................................................................................................................................................... 26 
 

See also:  
Installation Guide packaged with your printer. 
System Administrator Guide at www.xerox.com/office/6700docs. 
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the driver software and utilities on your computer. 

You can connect to your printer over a network using an Ethernet cable, or directly to your computer using 
a USB cable. Hardware and cabling requirements vary for the different connection methods. Routers, 
network hubs, network switches, modems, Ethernet, and USB cables are not included with your printer 
and must be purchased separately. Xerox recommends an Ethernet connection because it is typically 
faster than a USB connection, and it provides access to CentreWare Internet Services. 

For details on connection and network setup, print the Connection Setup page: 
1. At the control panel, touch Printer. 
2. On the Information tab, touch Print Reference Materials. 
3. Touch Connection Setup. 
4. Touch Print. 

For details on configuring the printer settings, see the System Administrator Guide at 
www.xerox.com/office/6700docs. 
 

Physically Connecting the Printer to the Network 

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is 
used for one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection provides direct access to printer settings using CentreWare Internet Services. 

To connect the printer: 
1. Connect the power cord to the printer, and plug the cord into an electrical outlet. 
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. 

Connect the other end of the Ethernet cable to a correctly configured network port on a hub 
or router. 

3. Turn on the printer. 
 

Initial Printer Setup 

Make sure that the printer is set up before installing the printer software. Setup includes enabling the 
optional features and assigning an IP address for the Ethernet network connection. If the printer has not 
been previously turned on and configured, see the System Administrator Guide at 
www.xerox.com/office/6700docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=userdocpdfs&FileName=sys_admin_guide&Language=English�
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Modifying General Settings 

You can modify printer settings such as the language, date and time, units of measurement, display 
brightness, and startup page from the control panel. 
1. At the control panel, touch Printer. 
2. Touch the Tools tab, then touch Setup. 
3. Touch General Settings, then touch the setting you want to change: 

• Language/Keyboard allows you to set the language and keyboard layout. 
• Date/Time allows you to set the time zone, date, time, and display format. 

 

Note: The date and time are automatically set through Network Time Protocol (NTP). To modify 
these settings, go to the Properties tab in CentreWare Internet Services and change the Date and 
Time Setup to Manual (NTP Disabled). 

 

• System Timeout allows you to specify how long the printer waits for input before returning to 
the main screen. 

• Display Brightness allows you to set the brightness level of the touch screen. 
• Startup Page allows you to specify if the Configuration Report prints each time the printer is 

turned on. 
4. Change settings as needed. 
5. To confirm the change, touch OK, or X to cancel it. 
6. Modify other settings, or touch Home to return to the main screen. 
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Installing the Software 

This section includes: 
• Operating System Requirements .................................................................................................................................. 26 
• Installing Drivers and Utilities for Windows ............................................................................................................. 27 
• Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later ............................................... 28 
• Installing Drivers and Utilities for UNIX and Linux ............................................................................................... 29 
• Other Drivers .......................................................................................................................................................................... 29 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If you 
cannot find the IP address, see Finding the IP Address of the Printer on page 20. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/6700drivers. 
 
 

Operating System Requirements 
• Windows XP SP1 and later, Windows Vista, Windows 7,Windows Server 2003, Windows Server 2008, 

Windows Server 2008 R2 
• Macintosh OS X version 10.5 and later 
• UNIX and Linux: Your printer supports connection to a variety of UNIX platforms through the 

network interface. For details, see www.xerox.com/office/6700drivers. 
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Installing Drivers and Utilities for Windows 

Install the Xerox® print driver to access all the features of your printer. 

To install the print driver software: 
1. Insert the Software and Documentation disc into your computer. The installer starts automatically. If 

the installer does not start, navigate to the appropriate drive on your computer and double-click 
Setup.exe. 

2. To change the language, click Language, select your language, then click OK. 
3. Click Agree to accept the license agreement. 
4. Select your printer from the list of discovered printers, then click Install. 
5. If your printer does not appear in the list of discovered printers, click Extended Search. 
6. If the printer still does not appear in the list of discovered printers, and you know the IP address: 

a. Click the Network Printer Icon (right) at the top of the gray window. 
b. Enter the IP Address or the DNS name for the printer. 
c. Click Search, then select your printer from the list of discovered printers. 
d. Click Next when the printer appears in the window. 

7. If the printer still does not appear in the list of discovered printers, and you do not know 
the IP address: 
a. Click Advanced Search. 
b. If you know the gateway address and subnet mask, click the top button and enter the addresses 

into the Gateway and Subnet Mask fields. 
c. If you know the IP address of another printer on the same subnet, enter the address in the IP 

Address field. 
d. Click Search, then select your printer from the list of discovered printers. 
e. Click Next when the printer appears in the window. 

8. Select the desired print driver: 
• PostScript (recommended) 
• PCL 5 
• PCL 6 

9. Click Install. 
10. Click Finish when the installation completes. 
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Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later 

Install the Xerox® print driver to access all the features of your printer. 

To install the print driver software: 
1. Insert the Software and Documentation disc into your computer. 
2. Double-click the disc icon on your desktop to see the .dmg file for your printer. 
3. Open the .dmg file, and navigate to the appropriate installer file for your operating system. 
4. Open the installer file. 
5. Click Continue to acknowledge the warning and introductory messages. 
6. Click Continue and accept the license agreement. 
7. Click Install to accept the current installation location, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click OK. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

11. Click OK to accept the print queue message. 
12. Select or clear the Set Printer as Default and Print a Test Page check boxes. 
13. Click Continue, then click Close. 
 

Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.4 
and later. 

 

To verify that the print driver recognizes the installed options: 
1. From the Apple menu, open System Preferences > Print. 
2. Select the printer in the list, then click Options and Supplies. 
3. Click Driver, then confirm that your printer is selected. 
4. Confirm that all of the options installed on the printer appear correct. 
5. If you change settings, click Apply Changes, close the window, and quit System Preferences. 
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Installing Drivers and Utilities for UNIX and Linux 

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a 
Xerox® Services for UNIX Systems code package and a printer support package. The Xerox® Services for 
UNIX Systems code package must be installed before installing the printer support package. 
 

Note: You must have root or superuser privileges to perform the UNIX print driver installation on 
your computer. 

 

1. At the printer, do the following: 
a. Verify that both the TCP/IP protocol and the proper connector are enabled. 
b. On the printer control panel, do one of the following for the IP address: 

• Allow the printer to set up a DHCP address. 
• Enter the IP address manually. 

c. Print the Configuration Report and keep it for reference. For details, see Configuration Report. 
2. At your computer, do the following: 

a. Go to www.xerox.com/office/6700drivers and select your printer model. 
b. From the Operating System menu, select UNIX, then click Go. 
c. Select the Xerox® Services for UNIX Systems package for the correct operating system. This 

package is the core package and must be installed before the printer support package. 
d. Click the Start button to begin downloading. 
e. Repeat steps a and b, then click the printer package for use with the Xerox® Services for 

UNIX Systems package that you selected earlier. The second part of the driver package is ready 
for download. 

f. Click the Start button to begin downloading. 
g. In the notes below the driver package that you selected, click the link for the Installation Guide, 

then follow the installation instructions. 
 

Notes: 

• To load Linux print drivers, perform the preceding procedures but select Linux as the operating 
system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. 
You can also use the CUPS driver included in the Linux package. 

• Supported Linux drivers are available at www.xerox.com/office/6700drivers. 
• For details about UNIX and Linux drivers, see the System Administrator Guide at 

www.xerox.com/office/6700docs. 
 
 

Other Drivers 

The following drivers are available for download at www.xerox.com/office/6700drivers. 
• The Xerox® Global Print Driver works with any printer on your network, including those printers made 

by other manufacturers. It configures itself for your individual printer upon installation. 
• The Xerox® Mobile Express Driver™ works with any printer available to your computer that supports 

standard PostScript. It configures itself for the printer you select every time you print. If you travel 
frequently to the same sites, you can save your favorite printers in that location and the driver saves 
your settings. 
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• Printing on Special Paper .................................................................................................................................................. 41 
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Supported Paper 

This section includes: 
• Recommended Media ........................................................................................................................................................ 32 
• Ordering Paper ...................................................................................................................................................................... 32 
• General Paper Loading Guidelines................................................................................................................................ 32 
• Paper That Can Damage Your Printer ........................................................................................................................ 33 
• Paper Storage Guidelines ................................................................................................................................................. 33 
• Supported Paper Types and Weights .......................................................................................................................... 34 
• Supported Standard Paper Sizes ................................................................................................................................... 34 
• Supported Paper Sizes and Weights for Automatic 2-Sided Printing ............................................................ 34 
• Supported Custom Paper Sizes ...................................................................................................................................... 35 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
to ensure the best print quality and to avoid jams. 

For best results, use Xerox® paper and media recommended for your printer. 
 
 

Recommended Media 

A list of paper and media recommended for your printer is available at: 
• www.xerox.com/paper Recommended Media List (United States) 
• www.xerox.com/europaper Recommended Media List (Europe) 
 

Ordering Paper 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/6700supplies. 
 
 

General Paper Loading Guidelines 
• Use only recommended Xerox® transparencies. Print quality could vary with other transparencies. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage your 
printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to 

collect moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid having food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored 

paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain. 
• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 

you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 
 

Trays Types and Weights 

Trays 1–6 Plain, Hole Punched, and Custom (60–90 g/m2) 
Letterhead, Heavyweight (80–120 g/m²) 
Cardstock (105–163 g/m²) 
Heavyweight Cardstock (160–220 g/m2) 
Labels (106–169 g/m2) 
Glossy Cardstock (105–163 g/m²) 
Heavyweight Glossy Cardstock (160–220 g/m2) 
Pre-Printed, Recycled (60–90 g/m2) 

Trays 1 and 2 only Envelope 
Transparency 

 

Note: You can print a list of supported paper and other media. At the control panel, touch Printer > 
Print Reference Materials > Paper Tips > Print. 

 
 

Supported Standard Paper Sizes 
 

Tray Number European Standard Sizes North American Standard Sizes 

All trays A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A5 (148 x 210 mm, 8.3 x 5.8 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 

Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
US Folio (216 x 330 mm, 8.5 x 13 in.) 

Trays 1 and 2 C5 envelope (162 x 229 mm, 6.4 x 9 in.) 
DL envelope (110 x 220 mm, 4.33 x 8.66 in.) 

Monarch envelope (98 x 190 mm, 3.875 x 7.5 in.) 
No. 10 envelope (241 x 105 mm, 4.125 x 9.5 in.) 

Tray 1 only A6 (105 x 148 mm, 4.1 x 5.8 in.) 
ISO B5 (176 x 250 mm, 6.9 x 9.8 in.) 
C6 envelope (114 x 162 mm, 4.5 x 6.38 in.) 
 

Note: ISO B5 can be printed from Trays 
2–6 using the Custom setting. 

 

Statement (140 x 216 mm, 5.5 x 8.5 in.) 
A7 envelope (133 x 184 mm, 5.25 x 7.25 in.) 
 

Note: Statement can be printed from Trays 2–6 
using the Custom setting. 

 

  
 

Supported Paper Sizes and Weights for Automatic 2-Sided Printing 
 

 Minimum Maximum 

Size 140 x 210 mm (5.5 x 8.3 in.) 215.9 x 355.6 mm (8.5 x 14 in.) 

Weight 60 g/m2 220 g/m2 
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Supported Custom Paper Sizes 
 

Tray Number Paper Sizes, Minimum–Maximum 

Tray 1 Width: 76.2–215.9 mm (3–8.5 in.) 
Length: 127.0–355.6 mm (5–14 in.) 

Trays 2–6 Width: 98.4–215.9 mm (3.9–8.5 in.) 
Length: 190.5–355.6 mm (7.5–14 in.) 
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Loading Paper 

This section includes: 
• Loading Paper in Tray 1 .................................................................................................................................................... 36 
• Loading Paper in Trays 2–6 ............................................................................................................................................. 37 
• Changing Paper Size, Type, and Color ........................................................................................................................ 40 
 
 

Loading Paper in Tray 1 
1. Open Tray 1. 

 
2. Pull out the extension tray for larger sizes. 

 
3. Move the width guides to the edges of the tray. 
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4. Insert the paper face down with the bottom edge leading into the printer. 

 
 

Notes: 

• Load hole punched paper face down with the holes toward the front of the printer. 
• For 2-sided printing, load letterhead and pre-printed paper face up. 

 

5. Adjust the width guides until they touch the edges of the paper. 

 
6. If the control panel prompts you, verify the size, type, and color information on the Tray Settings 

screen. To modify any incorrect setting, touch Size, Type, or Color, or OK if no changes are needed. 
7. Touch OK. 
 

Loading Paper in Trays 2–6 

Load all of the trays the same way. 
1. Pull out the tray until it stops. 
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2. Remove any paper that is a different size. 
3. Move the length and width guides out: 

a. Pinch the guide lever on each guide. 
b. Slide the guides outward until they stop. 
c. Release the levers. 

 

 
4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
 

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

 

5. Load the paper in the tray: 
• For 1-sided printing, insert the paper with the print side face up and the bottom edge to 

the right. 
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• For 2-sided printing, insert the paper with the print side face down and the bottom edge to 
the left. 

 
 

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer 
to jam. 

 

6. Adjust the length and width guides to fit the paper. 

 

 
7. Close the tray. 

 
8. If the control panel prompts you, verify the size, type, and color information on the Tray Settings 

screen. To modify any incorrect setting, touch Size, Type, or Color, or OK if no changes are needed. 
9. Touch OK. 
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Changing Paper Size, Type, and Color 

When Tray 1 is set to Bypass or Fully Adjustable mode, you can change paper settings each time you load 
the tray. When the tray is empty, the control panel prompts you to set the paper size, type, and color. 

When Trays 2–6 are set to Fully Adjustable mode, open the selected tray and load the desired paper. 
When you close the tray, the control panel prompts you to set the paper size, type, and color. 

When any paper tray is set to Dedicated mode, the tray accepts only the size of paper specified for the 
tray. If you move the guides to load a different paper size, the control panel displays an error message. 
Load the paper, then change the size, type, and color of paper at the control panel. 

To set the paper size, type, or color: 
1. At the control panel, touch Printer. 
2. Touch the Tools tab, then touch Tray Management. 
3. Touch Tray Settings, then select a dedicated tray. 
4. To modify the tray settings, touch Edit. 
5. Select Size, Type, or Color. 
6. Use the Up or Down Arrow as needed to select the desired paper setting. 
7. Touch OK. 
 

Note: To access the Tray Management menu, you could be required to log in as the system 
administrator. For details, see the System Administrator Guide at www.xerox.com/office/6700docs. 
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Printing on Special Paper 

This section includes: 
• Envelopes ................................................................................................................................................................................. 41 
• Labels ........................................................................................................................................................................................ 48 
• Glossy Cardstock................................................................................................................................................................... 49 
• Transparencies ...................................................................................................................................................................... 49 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/6700supplies. 
 

See also:  
www.xerox.com/paper Recommended Media List (United States) 
www.xerox.com/europaper Recommended Media List (Europe) 

 

 
 

Envelopes 

You can print envelopes from Trays 1 and 2. If you are printing more than five envelopes at a time, Xerox 
recommends that you use Tray 2. 
 

Guidelines for Printing Envelopes 
• Print quality depends on the quality and construction of the envelopes. Try another envelope brand 

if you do not get desired results. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid the excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on 

top of them. 
• In the print driver software, select Envelope as the paper type. 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
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Loading Envelopes in Tray 1 
 

Note: Do not load more than five envelopes in Tray 1. Overfilling the tray can cause the printer 
to jam. 

 

1. Remove any paper from Tray 1 and close the tray. 

 
2. Lift the right side door latch and open the door. 

 
3. To put the fuser in envelope mode, lower the fuser envelope lever in the upper left corner. 

 



Paper and Media 

 

 Phaser 6700 Color Printer 43 
 User Guide 
 

 

Note: When printing paper other than envelopes, raise the fuser envelope lever. 
 

4. If you are using the optional Finisher, raise the finisher lever at the paper exit. 

 
 

Note: When printing paper other than envelopes, push down the finisher lever. 
 

5. Close the right side door. 

 
6. Open Tray 1. 

 
7. Move the width guides to the edges of the tray. 
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8. Load the envelopes with the flaps closed, flaps facing up, and the short edge facing into the printer. 
• #10, Monarch, or DL envelopes: 

 
• C5 envelopes: 
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 CAUTION: Never use self-stick envelopes or envelopes with windows. They can lead to paper jams 
and can cause damage to the printer. 

 

Notes: 

• If you do not load envelopes in Tray 1 right after they have been removed from the packaging, 
they can bulge. Flatten them to avoid jams. 

 
• If envelopes still do not feed correctly, bend the leading edge of the envelopes 5 mm or less. 

 

9. Adjust the width guides to fit the envelopes. 
10. If the control panel prompts you, verify the size, type, and color information on the Tray Settings 

screen. To modify any incorrect setting, touch Size, Type, or Color, or OK if no changes are needed. 
11. Touch OK. 
 

Notes: 

• Make sure to return the fuser envelope lever up to the paper position after printing on 
envelopes. 

• If you are using the optional Finisher, lower the lever at the paper exit when finished printing 
envelopes. 

 
 

Loading Envelopes in Tray 2 
 

Note: Do not load envelopes above the 121–220 g/m² line. Overfilling the tray can cause the printer 
to jam. 

 

1. Lift the right side door latch and open the door. 
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2. To put the fuser in envelope mode, lower the fuser envelope lever in the upper left corner. 

 
 

Note: When printing paper other than envelopes, raise the fuser envelope lever. 
 

3. Close the right side door. 

 
4. If you are using the optional Finisher, raise the finisher lever at the paper exit. 
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Note: When printing paper other than envelopes, push down the finisher lever. 
 

5. Pull out the tray until it stops. 
6. Remove any paper that is a different size. 
7. Move the length and width guides out: 

a. Pinch the guide lever on each guide. 
b. Slide the guides outward until they stop. 
c. Release the levers. 

 

 
8. Load the envelopes in the tray: 

• Load No. 10, Monarch, or DL envelopes with the flaps closed, flaps down, and flaps toward 
the front. 

 
• Load C5 envelopes with the flaps closed, flaps down, and flaps toward the right. 
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9. Adjust the width guides: 
a. Pinch the guide lever on each guide. 
b. Slide the guides to the size of the paper. 
c. To secure the guides in position, release the levers. 

 
10. Close the tray. 

 
11. If the control panel prompts you, verify the size, type, and color information on the Tray Settings 

screen. To modify any incorrect setting, touch Size, Type, or Color, or OK if no changes are needed. 
12. Touch OK. 
 

Labels 

You can print labels from any tray. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 
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• Remove all other paper from the tray before loading labels. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 

 
 

Glossy Cardstock 

You can print glossy cardstock from any tray. 
 

Guidelines for Printing on Glossy Cardstock 
• Do not open sealed packages of glossy cardstock until you are ready to load them into the printer. 
• Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until 

ready to use. 
• Remove all other paper from the tray before loading glossy cardstock. 
• Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in 

the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal. 
• Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to 

curl and jam in the printer. 
• In the print driver, select the desired glossy cardstock type or select the tray loaded with the 

desired paper. 
 

Transparencies 

You can print transparencies from Trays 1 and 2. 
 

Guidelines for Printing on Transparencies 
• Remove all paper before loading transparencies in the tray. 
• Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor 

print quality. 
• Do not use transparencies with stripes on the side. 
• Do not fan transparencies. 
• After loading transparencies, change the paper type to Transparency on the printer touch screen. 
• In the print driver, select Transparency as the paper type. 
• Do not load more than 100 transparencies. Overfilling the tray can cause the printer to jam. 
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This chapter includes: 
• Printing Overview ................................................................................................................................................................. 52 
• Selecting Printing Options ................................................................................................................................................ 53 
• Printing Features .................................................................................................................................................................. 57 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure that 
you have the correct print driver software installed on your computer. For details, see Installing the 
Software on page 26. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type. 
3. Access the print settings in your software application. For most software applications, press CTRL+P 

for Windows, or CMD+P for Macintosh. 
4. Select your printer from the list. 
5. Access the print driver settings by selecting Properties or Preferences for Windows, or 

Xerox® Features for Macintosh. The title of the button can vary depending on your application. 
6. Modify the print driver settings as necessary, then click OK. 
7. Click Print to send the job to the printer. 
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Selecting Printing Options 

This section includes: 
• Print Driver Help .................................................................................................................................................................... 53 
• Windows Printing Options ................................................................................................................................................ 54 
• Macintosh Printing Options ............................................................................................................................................. 55 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printing Preferences become the default 
setting. Printing options that are set from within the software application are temporary. The application 
and the computer do not save the settings after the application is closed. 
 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help button (?) in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences settings appears in the Help window on two tabs: 
• Contents provides a list of the tabs at the top and the areas at the bottom of the Printing 

Preferences window. Use the Contents tab to find explanations for each of the fields and areas in 
Printing Preferences. 

• Search provides a field in which you can enter the topic or function for which you need information. 
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. In the Windows Taskbar, click Start > Settings > Printers and Faxes. 
2. In the Printers and Faxes folder, right-click the icon for your printer and click Printing Preferences. 
3. Click a tab in the Printing Preferences window, select options, then click OK to save. 
 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 
 

Setting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, change the Printing Preferences from the application 
before sending the job to the printer. For example, if you want to use the Photo print-quality mode when 
printing a particular document, select Photo in Printing Preferences before printing the job. 
 

Selecting Finishing Options for Windows 

If your printer has a finisher installed, select finishing options in the Printing Preferences of the print 
driver. You can staple up to 50 sheets of 90 g/m2 paper, and offset and stack up to 1000 sheets. 

To select stapling in the PostScript and PCL print drivers: 
1. In the print driver, click the Paper/Output tab. 
2. Click the arrow to the right of the Stapling section and select 1 Staple. 

To select offsetting in the PostScript and PCL print drivers: 
1. In the print driver, click the Advanced tab. 
2. Click the + next to Paper/Output. 
3. Click Request Offset. 
4. Click the arrow to the right of the field and select Offset Each Set. 
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Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select the printer, then click Properties. Click the tabs in the Printing Properties window and select 

the desired settings. 
3. Click Saved Settings at the bottom of the Printing Properties window, then click Save As. 
4. Type a name for the set of printing options, then click OK to save the set of options in the Saved 

Settings list. 
5. Select the name from the list to print using these options. 
 
 

Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select Xerox® Features from the Copies & Pages menu. 
4. Select the desired printing options from the drop-down lists. 
5. Click Print to send the job to the printer. 
 
 

Selecting Finishing Options for Macintosh 

If your printer has a finisher installed, select finishing options in the Printing Preferences of the print 
driver. You can staple up to 50 sheets of 90 g/m2 paper, and offset and stack up to 1000 sheets. 

To select stapling in the Macintosh print driver: 
1. In the print driver, click Copies & Pages, then select Xerox® Features. 
2. In the Paper/Output dialog box, click the arrow to the right of the Finisher section, then select 

1 Staple. 

To select offsetting in the Macintosh print driver: 
1. In the print driver, click Copies & Pages, then select Xerox® Features. 
2. On the Advanced tab, select Request Offset. 
3. Click the arrow to the right of the field and select Offset Each Set. 
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Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the desired printing options from the drop-down lists in the Print dialog box. 
4. Click Presets > Save As. 
5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 
6. To print using these options, select the name from the Presets list. 
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Printing Features 

This section includes: 
• Printing on Both Sides of the Paper ............................................................................................................................. 57 
• Selecting Paper Options for Printing ............................................................................................................................ 58 
• Printing Multiple Pages to a Single Sheet (N-Up) .................................................................................................. 58 
• Printing Booklets................................................................................................................................................................... 58 
• Using Color Options ............................................................................................................................................................ 59 
• Printing Covers ...................................................................................................................................................................... 60 
• Printing Inserts ...................................................................................................................................................................... 60 
• Printing Exception Pages .................................................................................................................................................. 61 
• Scaling ...................................................................................................................................................................................... 62 
• Printing Watermarks ........................................................................................................................................................... 62 
• Printing Mirror Images ....................................................................................................................................................... 63 
• Creating and Saving Custom Sizes ............................................................................................................................... 63 
• Selecting Job Completion Notification for Windows ............................................................................................ 64 
• Printing Special Job Types ................................................................................................................................................ 64 
 
 

Printing on Both Sides of the Paper 

Printing a 2-Sided Document 

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print 
driver uses the settings for portrait or landscape orientation from the application for printing the 
document. 
 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These 
settings override the application page orientation settings. 
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Portrait Landscape 

 

 
 

 
 

 
 

 

Portrait 
2-Sided Print 

Portrait 
2-Sided Print, Flip on Short 
Edge 

Landscape 
2-Sided Print 

Landscape 
2-Sided Print, Flip on Short 
Edge 

 
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to use 
based on the document size, paper type, and paper color you specify. You can also select a specific tray 
loaded with the desired paper. 
 

Printing Multiple Pages to a Single Sheet (N-Up) 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet (N-Up) on the Layout/Watermark tab. 

 
  
 

Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep specifies how much the page images are shifted outward, in tenths of a point. Shifting 

compensates for the thickness of the folded paper, which would cause the page images to shift 
slightly outward when folded. You can select a value from zero to 1 point. 
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Gutter Creep 

 
 

 
 
 
 
 

 
 

Using Color Options 

The Color Options control the way the printer uses color to produce your document. The Windows 
PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each 
system has three standard modes of color control for normal use and Custom Color Options for the more 
advanced users. 

The three standard color modes are: 
• Automatic Color applies the best color correction to text, graphics, and images. This setting is 

recommended. 
• Vivid Color applies automatic color correction to make office colors more saturated. 
• Black and White converts all color in the document to black and white or shades of gray. 

Custom Color Options provide three ways of adjusting the colors for more specific color requirements. 
Click the Custom Color Options bar to open the Custom Color Options window: 
• Color By Words provides a three step process for defining custom color correction. By making a 

selection from each of the three fields, you create a sentence for controlling the color characteristics 
of the document. You can create several sentences to more precisely control the color content of the 
document. 
The sentence structure is made of three parts: 
• What Color to Change? provides a drop-down list to select a color or range of colors to adjust, 

such as All Foliage-Green Colors. 
• How Much Change? lets you select how much effect to make, such as A Lot More, to the 

selected color. 
• What Type of Change? lets you select the type of change, such as Vivid, from the 

drop-down list. 
As you create a Color By Words sentence, it appears in the window below the selection fields. 

• Color Correction provides a list of commercial press, spot color, CIE, and gray image simulations 
from which you can select to match your document color. 



Printing 

 

60 Phaser 6700 Color Printer 
 User Guide 
 

• Color Adjustments provides a set of six sliders for adjusting the individual components of the 
selected colors. Use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and 
yellow components of the color. 

  
 

Printing Covers 

A cover is the first or last page of a document. You can select paper sources for the covers that are 
different from the source used for the body of a document. For example, you can use your company 
letterhead for the first page of a document. You can also use heavyweight paper for the first and last 
pages of a report. You can use any applicable paper tray as the source for printing covers. 

Select an option for printing covers: 
• No Covers cancels any previous Covers settings. 
• Front Only prints the first page on paper from the specified tray. With automatic 2-sided printing, 

the first two pages print on the cover. 
• Back Only prints the back page on paper from the specified tray. With automatic 2-sided printing, 

the last two pages print on the cover when the page count is even. 
• Front and Back: Same prints the front and back covers from the same tray. 
• Front and Back: Different prints the front and back covers from different trays. 
 

Printing Inserts 

You can add blank or pre-printed inserts before page one of each document or after designated pages 
within a document. Adding an insert after designated pages within a document separates sections, or 
acts as a marker or placeholder. Make sure that you specify the paper to use for the inserts. 

Modify these settings when printing inserts: 
• Insert Options provides the options to place an insert After Page X, where X is the specified page, or 

Before Page 1. 
• Insert Quantity specifies the number of pages to insert at each location. 
• Page(s) specifies a page or a range of pages after which you want an insert added. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to add inserts after pages 1, 6, 9, 10, and 11, type: 1, 6, 9-11. 

• Paper displays the default size, color, and type of paper selected in Use Job Settings for the inserts. 
Use the Down Arrow to the right of the Paper field to select a different paper size, color, or type. 

• Job Settings displays the attributes of the paper for the remainder of the job. 
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Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
• Page(s) specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down 
Arrow to the right of the Paper field to select a different paper size, color, or type. 

• 2-Sided Printing allows you to select 2-sided printing options. Click the Down Arrow to select 
an option: 
• 1-Sided Print prints the exception pages on one side only. 
• 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the 

long edge. The job can then be bound on the long edge of the pages. 
• 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and 

flips the pages on the short edge. The job can then be bound on the short edge of the pages. 
• Job Settings displays the attributes of the paper for the remainder of the job. 
 

Notes: 

• If your printer does not support automatic 2-sided printing, not all of the options are available. 
• Some combinations of 2-sided printing with certain paper types and sizes can produce 

unexpected results. 
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Scaling 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. The 
default setting is 100%. 
 

50% 100% 200% 

   

In Windows, the Scale Options are located in the print driver on the Paper/Output tab in the Paper field. 
Click the arrow at the right side of the Paper field and select Other Size to access the Scale Options: 
• No Scaling does not increase or decrease the size of the image from the original. 
• Automatic Scaling changes the print from one standard paper size to another standard paper size. 

The Original Document Size is scaled to fit on the selected output paper size shown in the Output 
Paper Size field. 

• Manual Scaling changes the output print size by the percentage entered into the field under the 
graphic to the right of the Scale Options. 

 

Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document 
before distribution. 

 

Using the watermark options, you can do the following: 
• Create a watermark or edit an existing watermark using the Watermark Editor: 

• Name allows you to give the new watermark a unique name. 
• Options enables you to use text, time stamps, or graphics for the watermark. 
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• Text provides a field in which you enter the text to be printed as the watermark. 
• Font and Color determine the font, size, style, and color of the watermark. 
• Angle sets the degree of rotation applied to the text or graphics used for the watermark. 
• Density defines how faint or how prominent the watermark appears on the pages. 
• Position from center determines the position of the watermark on the page. The default 

position is in the center of the printed pages. 
• Place a watermark on the first page or on every page in a document. 
• Print a watermark in the foreground or background or blend it with the print job. 
 

Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right 
when printed. 
 

Creating and Saving Custom Sizes 

You can print custom-size paper from Trays 1–6. Custom size paper settings are saved in the print driver 
and are available for you to select in all your applications. 

See Supported Custom Paper Sizes on page 35 for paper sizes that are supported for each tray. 

To create and save custom sizes for Windows: 
1. Click the Paper/Output tab of the print driver. 
2. Click the arrow at the right of the Paper field, then select Other Size > Output Paper Size > New. 
3. In the New Custom Size window, enter the height and width of the new size, then select the units. 
4. Enter a title for the new size in the Name field, then click OK to save. 

To create and save custom sizes for Macintosh: 
1. In the application, click File > Page Setup. 
2. Click Paper Sizes, then select Manage Paper Sizes. 
3. In the Manage Paper Sizes window, click the plus sign (+) to add a new size. 
4. Double-click Untitled at the top of the window and type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click the arrow to the right of the Non-Printable Area field and select the printer from the drop-down 

list. Or set the top, bottom, right, and left margins for User Defined margins. 
7. Click OK to save the settings. 
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Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer screen 
with the name of the job and the name of the printer where it was printed. 
 

Note: This feature is only available on a Windows computer printing to a network printer. 
 

To select job completion notification: 
1. In the print driver, click More Status at the bottom of any tab. 
2. In the Status window, click Notification, then click the desired option. 
3. Close the Status window. 
 
 

Printing Special Job Types 
 

Note: To use any of the special job types, your printer must have the optional hard drive installed. 
  
 

Sample Set 

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the remaining 
copies at the printer. After you review the sample copy, you can select the job name from the printer 
control panel to print the additional copies. 

To release the remainder of prints after printing a sample set: 
1. At the control panel, touch Jobs. 
2. Touch the corresponding print job in the list. 
 

Note: The control panel displays Held: Sample Set next to the job name. 
 

3. Touch Release. 
The remainder of the job prints, and the job is deleted from the printer hard drive. 

 

Secure Print 

Secure Print allows you to associate a 4–10 digit passcode number with a print job when sending it to the 
printer. The job is held at the printer until the same passcode is entered at the control panel. 

To release a Secure Print job for printing: 
1. At the control panel, touch Jobs. 
2. Touch Personal and Secure Jobs. 
3. Touch your assigned private folder. 
4. Type the passcode assigned to the job, then touch OK. 
5. Touch the corresponding print job in the list. 
6. Touch Print. 

The job prints, then is deleted from the printer hard drive. 
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Saved Job 

Saved Job allows you to save a print job to a folder on the printer. Using the controls in the Saved Jobs 
window, you can save the job, or you can print and save the job for future use. You can also set the access 
to the print job as follows: 
• Public requires no passcode and allows any user to print the file from the control panel of the printer. 
• Private requires a passcode so that only a user with the passcode can print the file. 

When the Saved Job is no longer needed, you can delete it from the control panel of the printer. 

To print a public saved job: 
1. At the control panel, touch Jobs. 
2. Touch Saved Jobs. 
3. Touch Public. 
4. To enter the number of copies, touch Quantity, then touch OK. 
5. Touch the name of the desired print job. 
6. To submit the print job, touch Print. 

The job prints, and remains on the printer hard drive for future use. 

To print a private saved job: 
1. At the control panel, touch Jobs. 
2. Touch Saved Jobs. 
3. Touch your assigned private folder. 
4. Type the passcode assigned to the job, then touch OK. 

The screen shows a list of saved print jobs that use that passcode. 
5. To enter the number of copies, touch Quantity, then touch OK. 
6. Touch the name of the desired print job. 
7. To submit the print job, touch Print. 

The job prints, and remains on the printer hard drive for future use. 
 

Personal Print 

Personal Print allows you to store a document in the printer, then print it from the control panel. 

To print a personal job: 
1. At the control panel, touch Jobs. 
2. Touch Personal and Secure Jobs. 
3. Touch your assigned private folder. 
4. Touch the corresponding print job in the list. 
5. Touch Print. 

The job prints, then is deleted from the printer hard drive. 
 

Note: You can also print all jobs in the list at once, delete an individual job, or delete all jobs in the list. 
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Maintenance and Cleaning 

This section includes: 
• General Precautions ............................................................................................................................................................ 68 
• Cleaning the Printer ............................................................................................................................................................ 69 
• Routine Maintenance ......................................................................................................................................................... 79 
• Periodic Maintenance ........................................................................................................................................................ 89 
 
 

General Precautions 
 

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed 
in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners 
increase the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the imaging units. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Make sure any parts removed during cleaning are replaced before you plug in the printer. 
 



Maintenance 

 

 Phaser 6700 Color Printer 69 
 User Guide 
 

Cleaning the Printer 

This section includes: 
• Cleaning the Printer Exterior ........................................................................................................................................... 69 
• Cleaning the Printer Interior ........................................................................................................................................... 70 
• Cleaning the Density Sensor ........................................................................................................................................... 72 
• Cleaning the Feed Rollers ................................................................................................................................................. 76 
 
 

Cleaning the Printer Exterior 

Regular cleaning keeps the touch screen and control panel free from dust and dirt. 

To clean the printer exterior: 
1. To avoid activating buttons and menus, press the Power Saver button. 

 
2. To remove finger prints and smudges, clean the touch screen and control panel with a soft, 

lint-free cloth. 
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3. Press the Power Saver button again to return the printer to Ready mode. 
4. Use a soft lint-free cloth to clean the outside of the output tray, paper trays, and other exterior areas 

of your printer. 

 
 

Cleaning the Printer Interior 

Clean the interior of the printer regularly to prevent stains inside the printer that can deteriorate printing 
quality. Clean the printer interior whenever you replace an imaging unit. 
 

Note: You can watch a video at the printer that shows the cleaning procedure. Select Printer > 
Tools > Troubleshooting > Resolve Problems > Vertical White Lines or Streaks - One Color, then 
touch the Video button to watch the Clean Laser Window video. 

  

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cord from 
the grounded outlet before performing maintenance. 

 

1. Turn off the printer. 

 
2. Open the front door. 
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3. Remove the cleaning rod from the back of the front door.  

 
4. Insert the cleaning rod into one of the four cleaning holes until it clicks, then pull it out. Repeat this 

two more times. 

 
5. Repeat the process for the other three holes. 
6. Return the cleaning rod to its original location. 
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7. Close the front door. 

 
 

Note: Each new imaging unit includes a replacement cleaning pad. Ensure that you replace the 
cleaning pad at the same time you replace the imaging unit. 

 
 

Cleaning the Density Sensor 

A message appears on the control panel when the density sensor needs cleaning. 
 

Note: You can watch a video at the printer that shows the cleaning procedure. Select Printer > 
Tools > Troubleshooting > Resolve Problems > Colors Too Light or Too Dark, then touch the Video 
button to watch the Clean Color Density Sensor video. 

 

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cord from 
the grounded outlet before performing maintenance. 

  

 CAUTIONS:  

• Ensure that nothing touches or scratches the surface of the transfer belt. Scratches, dirt, 
or oil from your hands on the belt can deteriorate print quality. 

• To protect the imaging units against bright light, close the imaging unit door within five 
minutes. Longer exposure can deteriorate print quality. 

 

1. Turn off the printer. 
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 WARNING: Some parts can be hot. Allow 30 minutes for the printer to cool before proceeding. 

 
2. Open the front door. 

 
3. Remove any paper from Tray 1 and close the tray. 
4. Lift the right side door latch and open the door. 

 
5. Rotate the two lock levers to release the imaging unit door, then pull it open. 
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6. Slide the transfer belt out of the way: 
a. Grasp the handle on the front of the transfer belt. 

 
b. Pull out the transfer belt until the line on the belt becomes visible. 

 
7. Slide the gold-colored tab back and forth five times. 

 
8. Reinstall the transfer belt: 

a. Slide the transfer belt into the printer, stopping when the visible line reaches the printer. 

 



Maintenance 

 

 Phaser 6700 Color Printer 75 
 User Guide 
 

b. Lower the handles. 

 
c. Push the transfer belt in until it stops. 

 
9. Close the imaging unit door. 

 
10. Rotate the two lock levers to secure the imaging unit door. 
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11. To close the right side door, place your hand near the latch and firmly push the door toward 
the printer. 

 
 

Note: If the right side door does not close, the transfer belt is not fully seated. 
 

12. Close the front door of the printer. 

 
13. Turn on the printer. 
 

Cleaning the Feed Rollers 

Periodically inspect the feed rollers in each of the installed trays, and clean them if paper dust or other 
residue is visible. Dirt on the feed rollers can cause paper jams or deteriorate print quality. 
1. Remove the tray from the printer. 
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2. Turn the feed roller until the roller hook is visible. 

 
 

Note: The rollers are located approximately 165 mm (6.5 in.) inside the printer, measuring from the 
tray opening. 

 

3. Pull the feed roller hook out of the groove on the axle, then slide the feed roller to the front. 

 

 
4. Remove the second feed roller using a similar method. 
5. Wipe the rollers with a clean, lint free cloth moistened with water. 
6. Align the hole of the first feed roller with the axle. 
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7. Slide the feed roller along the axle until the protrusions fit completely into the slots, and the roller 
hook reseats into the groove. 

 
8. Install the second feed roller using a similar method. 
9. To clean the feed roller in the tray, turn the roller with one hand while wiping it with the cloth. 
10. Reinsert the tray into the printer. 
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Routine Maintenance 

This section includes: 
• Replacing the Toner Cartridges ..................................................................................................................................... 79 
• Replacing the Waste Cartridge ...................................................................................................................................... 81 
• Replacing the Imaging Units .......................................................................................................................................... 82 
• Replacing the Staple Cartridge ...................................................................................................................................... 87 

For information on ordering supplies, see Ordering Supplies on page 104. 
 
 

Replacing the Toner Cartridges 

A message appears on the control panel when a toner cartridge must be replaced. 
1. Open the front door of the printer. 

 
2. Slowly pull out the toner cartridge you are replacing. 
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 CAUTION: Do not touch the parts shown in the illustration. 
 

 CAUTION: Be careful not to spill toner when handling the toner cartridge. 
 

3. Remove the new toner cartridge from the packaging. 
4. Shake the toner cartridge five or six times to distribute the toner evenly. 

 
 

 CAUTION: Be careful not to spill toner when handling the toner cartridge. 
 

5. Align the arrow on the toner cartridge with the arrow on the printer, then push the cartridge in slowly 
until it stops. 

 
6. Close the front door of the printer. 
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Replacing the Waste Cartridge 

A message appears on the control panel when a waste cartridge must be replaced. 
1. Unpack a new waste cartridge. Save the plastic bag for the used cartridge. 
2. Open the front door of the printer. 

 
3. Grasp the handle of the waste cartridge and pull it out toward you. 

 
4. Hold the waste cartridge with your other hand and pull it out of the printer. 
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 CAUTION: Be careful not to spill toner when handling the waste cartridge. 
 

 CAUTION: After removing the waste cartridge, do not touch the part as shown in the 
following illustration. 

 

 
5. Place the used waste cartridge in the plastic bag that came with the new cartridge, and seal the bag. 
6. Insert the new waste cartridge into the slot and push it until it stops. 

 
7. Close the front door of the printer. 

 
 

Replacing the Imaging Units 

A message appears on the control panel when an imaging unit must be replaced. 
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 CAUTION: To protect the imaging units against bright light, close the imaging unit door within five 
minutes. Longer exposure can deteriorate print quality. 

 

1. Open the front door of the printer. 

 
2. Rotate the two lock levers to release the imaging unit door, then pull it open. 

 
3. Remove the imaging unit you are replacing: 

a. Grasp the handle of the imaging unit, then pull it out halfway. 
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b. Grasp one side of the imaging unit with the other hand and pull the imaging unit straight out of 
the printer. 

 
 

 CAUTION: Do not touch the parts shown in the illustration. 
 

 CAUTION: Be careful not to spill toner when handling the imaging unit. 
 

4. Install the new imaging unit: 
a. Unpack a new imaging unit. 

 

 CAUTION: To protect the imaging unit against overexposure to bright light, do not remove the 
orange protective covering until after inserting the cartridge into the printer. 

 

b. Pull the two ribbons out of the new imaging unit and discard them. 

 
c. Carefully slide the imaging unit into the correct slot. 
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d. Remove the orange protective covering from the installed imaging unit and discard it. 

 

 
5. Close the imaging unit door. 

 

 
6. Rotate the two lock levers to secure the imaging unit door. 
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7. Remove the cleaning rod from the back of the front door.  

 
8. Remove the cleaning pad by pinching the tabs behind the pad. 

 
9. Unpack a new cleaning pad from the imaging unit box. 
10. Attach the new cleaning pad to the cleaning rod. 

 
11. Insert the cleaning rod into one of the four cleaning holes until it clicks, then pull it out. Repeat this 

two more times. 
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12. Insert the cleaning rod into each of the other three cleaning holes. 
13. Return the cleaning rod to its original location. 

 
14. Close the front door of the printer. 

 
 

Replacing the Staple Cartridge 

A message appears on the control panel when a staple cartridge must be replaced. 
 

 WARNING: Do not perform this procedure while the printer is printing. 
 

1. Unpack a new staple cartridge and remove the packing material. 
2. Open the front door of the finisher. 
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3. Remove the empty staple cartridge from the printer by pulling it toward you. 

 
 

Note: Ensure that the metal part on the new cartridge is lowered as shown. 
 

 
4. Insert the new staple cartridge into the finisher. 

 
5. Close the front door of the finisher. 
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Periodic Maintenance 

This section includes: 
• Replacing the Fuser ............................................................................................................................................................. 89 
• Replacing the Maintenance Kit ...................................................................................................................................... 91 

For information on ordering supplies, see Ordering Supplies on page 104. 
 
 

Replacing the Fuser 
 

Note: You can watch a video at the printer that shows the removal procedure. Select Printer > Tools > 
Troubleshooting > Resolve Problems > Repeating Spots or Lines, then touch the Video button to 
watch the Fuser video. 

 

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cord from 
the grounded outlet before performing maintenance. 

 

 WARNING: To avoid burns, do not replace the fuser immediately after printing. The fuser becomes 
hot during use. 

 

1. Turn off the printer. 

 
2. Wait for 30 minutes before proceeding. 
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3. Remove any paper from Tray 1 and close the tray. 
4. Lift the right side door latch and open the door. 

 
5. Grasp both handles of the installed fuser and pull it out. 

 
6. Unpack the new fuser. 
7. Grasp both handles of the fuser and install it in the printer. 

 



Maintenance 

 

 Phaser 6700 Color Printer 91 
 User Guide 
 

8. Close the right side door. 

 
9. Turn on the printer. 
 

Replacing the Maintenance Kit 

A message appears on the control panel when the Maintenance Kit must be replaced. 
 

Note: You can watch a video at the printer that shows the removal procedure. Select Printer > Tools > 
Troubleshooting > Resolve Problems > Repeating Spots or Lines, then touch the Video button to 
watch the Maintenance Kit video. 

 

 
 

 WARNING: To prevent electric shock, always turn off the printer and disconnect the power cord from 
the grounded outlet before performing maintenance. 

 

1. Turn off the printer. 
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 WARNING: Some parts can be hot. Allow 30 minutes for the printer to cool before proceeding. 
 

 
2. Remove Tray 2 from the printer. 

 
3. Replace the feed rollers inside the printer: 

a. Turn the feed roller until the roller hook is visible. 
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Note: The rollers are located approximately 165 mm (6.5 in.) inside the printer, measuring from the 
tray opening. 

 

b. Pull the feed roller hook out of the groove on the axle, then slide the feed roller to the front. 

 

 
c. Remove the second feed roller using a similar method. 
d. Align the hole of the new feed roller with the axle. 

 
e. Slide the feed roller along the axle until the protrusions fit completely into the slots, and the 

roller hook reseats into the groove. 
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f. Install the second feed roller using a similar method. 
4. Replace the feed roller cartridge in the tray: 
 

Note: The procedure is the same for replacing the feed roller cartridge in any of the standard and 
optional trays. 

 

a. Move the feed roller cover to the left to open it, and hold the cover open. 

 
b. Turn the feed roller cartridge to the right. 

 
c. Pull out the rear axle, then the front axle, and remove the feed roller cartridge. 
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d. Unpack the new feed roller cartridge. 
e. Move the feed roller cover to the left to open it, and hold the cover open. 

 
f. Slide the front axle, then the rear axle of the feed roller cartridge into the holes in the tray. 

 
g. Turn the feed roller cartridge to the left to lock it in place. 

 
h. Move the feed roller cover to the right to close it. 
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5. Insert the tray into the printer. 

 
6. Replace the transfer roller: 

a. Lift the right side door latch and open the door. 

 
b. Unlock the two levers on the transfer roller and lift up the roller to remove it. 
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c. Grasp the levers on both sides of the new transfer roller and align the arrows on the roller with 
the arrows inside the printer. 

 
d. Lower the front of the transfer roller until it clicks into place. 

 
7. Remove the transfer belt: 

a. Open the front door of the printer. 

 
b. Rotate the two lock levers to release the imaging unit door, then pull it open. 
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c. Grasp the handle on the front of the transfer belt. 

 
d. Pull out the transfer belt until the line on the belt becomes visible. 

 
e. Grasp the handles on the top of the transfer belt, then pull to remove it from the printer. 

 
 

 CAUTION: Do not hold the parts as shown in the illustration. Doing so can degrade print quality. 
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8. Slide the gold-colored tab back and forth five times. 

 
9. Unpack a new transfer belt and place it on a level surface. 

 
10. Remove the protective parts. 
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11. Replace the transfer belt: 
a. Grasp the handles on top of the transfer belt. 

 
 

 CAUTION: Do not hold the parts as shown in the illustration. Doing so can degrade print quality. 
 

 
b. Align the arrows on the transfer belt with the arrows on the printer. 
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c. Slide the transfer belt into the printer, stopping when the visible line reaches the printer. 

 
d. Lower the handles. 

 
e. Push the transfer belt in until it stops. 

 
12. Close the imaging unit door. 
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13. Rotate the two lock levers to secure the imaging unit door. 

 
14. Close the front door of the printer. 

 
15. Close the right side door. 

 
 

Note: If the right side door does not close, the transfer belt is not fully seated. 
 

16. Turn on the printer. 
17. Reset the Maintenance Kit counter: 

a. At the control panel, touch Printer. 
b. Touch the Tools tab, then touch Setup. 
c. Touch Service Tools. 
d. Touch Reset HFSI Counters > Maintenance Kit > Reset Counter. 
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Billing and Usage Information 

Billing and printer usage information appears on the Billing Meters information screen. The impression 
counts shown are used for billing. 
1. At the control panel, touch Printer. 
2. On the Information tab, touch Billing Meters to see basic impression counts: 

• Color impressions: Number of pages printed that specify color. 
• Black impressions: Number of pages printed with no color specified. 
• Total impressions: Total number of color impressions plus black impressions. 

 

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed 
on two sides counts as two impressions. 

 

3. Touch Usage Counters to see detailed usage information. 
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Ordering Supplies 

This section includes: 
• Locating the Serial Number ........................................................................................................................................... 104 
• Consumables ........................................................................................................................................................................ 104 
• Routine Maintenance Items ......................................................................................................................................... 105 
• Customer Replaceable Units ......................................................................................................................................... 105 
• When to Order Supplies ................................................................................................................................................... 105 
• Viewing Printer Supply Status ...................................................................................................................................... 106 
• Recycling Supplies .............................................................................................................................................................. 106 
 
 

Locating the Serial Number 

You need the printer serial number to order supplies or to contact Xerox for assistance. The serial number 
is located on the right side of the printer chassis below the fuser, behind the right side door. You can also 
view the serial number on the control panel. 

To view the serial number on the control panel: 
1. At the control panel, touch Printer. 
2. On the Information tab, touch About This Printer. 

The General tab displays the model, serial number, version, and activation date. 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer include the following: 
• Genuine Xerox® Toner Cartridges (Cyan, Magenta, Yellow, and Black) 
• Staple Cartridge, if the optional Finisher is installed 
 

Note: Each consumable includes installation instructions. 
  

 CAUTION: Use of toner other than Genuine Xerox® Toner can affect print quality and printer 
reliability. It is the only toner designed and manufactured under strict quality controls by Xerox for 
specific use with this printer. 
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Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 
 

Note: Each routine maintenance item includes installation instructions. 
 

Routine maintenance items for this printer include the following: 
• Imaging Units (Cyan, Magenta, Yellow, and Black) 
• Waste Cartridge 
 

Customer Replaceable Units 

Customer replaceable units (CRUs) are printer parts that can be replaced without need for technical 
service intervention. These parts have longer rated lives than routine maintenance items. 
 

Note: Each customer replaceable unit includes installation instructions. 
 

Customer Replaceable Units for this printer include the following: 
• 110 V Fuser for Phaser 6700 printer 
• 220 V Fuser for Phaser 6700 printer 
• Maintenance Kit, including a Feed Roller Kit, Transfer Roller, and Transfer Belt 
• Tray 1 Feed Roller 
 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must 
be replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/6700supplies. 
 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 
 
 
 
 
 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=order&Language=English�
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Viewing Printer Supply Status 

You can check the status of printer supplies at any time. 
1. To view the Supplies tab, do one of the following: 

• At the control panel, touch the Printer button, then touch the Supplies tab. 
• Touch one of the C, M, Y, K icons in the lower right of the main screen. 

2. To view details about a toner cartridge, including the part number for reordering, touch C, M, Y, or K. 
3. Touch Close to return to the Supplies tab. 
4. To view details about the fuser, waste cartridge, imaging units, maintenance kit, or staple cartridge, 

touch Other Supplies. Use the Up or Down Arrow to scroll through the list, then select the details you 
want to view. 

5. Touch the Back arrow to return to the Other Supplies screen. 
6. To print the Supplies Usage page, touch the Print icon, then touch Supplies Usage. 
7. To return to the main screen, touch Home. 
 

Recycling Supplies 

For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa. 

Supplies include a prepaid return label. Please use it to return used components in their original boxes 
for recycling. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=recyclesupplies&Language=English%20%20�
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Moving the Printer 

• Always turn off the printer and wait for the printer to shut down. 
• Disconnect the power cord from the back of the printer. 
• Always use at least three people to lift the printer. 
• When lifting the printer, grasp the areas as shown. 
• Keep the printer level to avoid toner spillage. 
 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered by 
the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, 
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by 
improper moving. 

 

 
 

 CAUTION: The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. 
Coverage could vary outside these areas. Please contact your Xerox representative for details. 
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• General Troubleshooting ................................................................................................................................................ 110 
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• Getting Help ......................................................................................................................................................................... 137 
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General Troubleshooting 

This section includes: 
• Printer Does Not Turn On ............................................................................................................................................... 110 
• Printer Resets or Turns Off Frequently ...................................................................................................................... 110 
• Printing Takes Too Long.................................................................................................................................................. 111 
• Document Prints From Wrong Tray ........................................................................................................................... 111 
• Document Fails to Print ................................................................................................................................................... 112 
• Printer is Making Unusual Noises ................................................................................................................................ 112 
• Automatic 2-Sided Printing Problems ....................................................................................................................... 112 
• Date and Time are Incorrect ......................................................................................................................................... 112 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 
 

Printer Does Not Turn On 
 

Probable Causes Solutions 

The power switch is not turned on. Turn on the switch. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer power switch, and plug the power cord securely 
into the outlet. 

Something is wrong with the outlet connected 
to the printer. 

• Plug another electrical appliance into the outlet and see if it 
operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 150. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
 
 

Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, confirm that the power cord is correctly plugged 
into the printer and the outlet, then turn on the printer. 
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A system error occurred. Contact your Xerox® service representative with the error code and 
message. Check the control panel fault history. For details, see 
Viewing Error Messages on the Control Panel on page 137. 

  
 

Printing Takes Too Long 
 

Probable Causes Solutions 

The printer is set to a slower printing mode, 
for example, for printing on heavyweight 
paper or transparencies. 

It takes more time to print on certain types of special media. Make 
sure that the paper type is set properly in the driver and at the 
printer control panel. 

The printer is in Energy Saver mode. Wait. It takes time for printing to start when the printer is coming 
out of Energy Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, print 
some Information pages such as the Office Demo Page. If the page 
does not print at the rated speed of the printer, you could have a 
network or printer installation issue. 

The job is complex. Wait. No action needed. 

The print-quality mode in the driver is set 
to Photo. 

Change the print-quality mode in the print driver to Standard. 

The printer quality is set to Photo and the 
printer is being used for complex, 2-sided 
print jobs. 

Increase memory size to 2 GB RAM. 

 
 

Document Prints From Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application from 

which you are printing. 
3. Set the paper source to match the tray selected in the print driver 

or set the paper source to Automatically Select. 
 

Note: To have the print driver select the tray, set the tray used as 
the paper source to Auto Selection Enabled. 
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Document Fails to Print 
 

Probable Causes Solutions 

Selected tray has wrong paper size loaded. To view the Job Status for a failed print on the touch screen: 
1. At the control panel, touch Jobs. 
2. Find the failed print job in the list. 
3. Note the status of the failed print job, such as Held: Resources 

Required. 
4. For details, touch the print job, then touch Job Details. 
5. Note the Tray number listed under Resources and the status of 

the selected tray. 
6. Load the correct size paper in the tray or select another tray. 
 

Application and print driver have conflicting 
tray selections. 

For details, see Document Prints from Wrong Tray on page 111. 

  
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

One of the trays is not installed correctly. Open and close the tray from which you are printing. 

There is an obstruction or debris inside 
the printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox® service representative. 

  
 

Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using the correct paper. For details, see Supported 
Paper Sizes and Weights for Automatic 2-Sided Printing on page 34. 
Envelopes, labels, transparencies, and paper heavier than 220 g/m² 
cannot be used for 2-sided printing. 

Incorrect setting. • In the print driver Properties, select 2-Sided Print on the Paper/Output 
tab. 

• Check the settings at the control panel. Touch Printer > Setup > 
Output Settings > 2-Sided Printing. 

  

Note: The Phaser 6700N does not support automatic 2-sided printing. 
 
 

Date and Time are Incorrect 

The date and time are set automatically when the printer is connected to a network that has a Network 
Time Protocol (NTP) server. NTP is used to synchronize the internal clocks of computers over a network 
connection at system startup and every subsequent 24-hour period thereafter. This feature ensures that 
the internal clock of the printer stays synchronized with the NTP server you specify. 
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Probable Causes Solutions 

The Date and Time Setup is set to Manual 
(NTP Disabled). 

Change the Date and Time to Automatic by enabling 
NTP. Enable NTP using CentreWare Internet Services: 
1. Open your Web browser, type the IP address of your 

printer in the address field, then press Enter or 
Return. 

 

Note: If you do not know the IP address of your printer, 
see Finding the IP Address of Your Printer on page 20. 

2. Click the Properties tab. 
3. In the navigation pane, click the arrow to the left of 

General Setup. 
4. From the expanded General Setup menu, select Date 

and Time. 
5. In the Date and Time page, click the arrow at the 

right of the Date and Time Setup box. 
6. Select Automatic using NTP. 
7. In the NTP Server Settings, enter the IP address for 

the NTP server. 
8. Click Apply. 

 

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually: 
1. At the control panel, touch Printer. 
2. Touch the Tools tab, then touch Setup. 
3. Touch General Settings > Date/Time. 
4. Change information as needed: 

a. Touch Time Zone, then use the Up and Down 
Arrows to select your geographic region and time 
zone, then touch OK. 

b. Touch Date, then use the Left and Right Arrows 
to select the year, month, and day, then touch OK. 

c. Touch Time, then touch Hour or Minutes. Use the 
keypad to enter the numbers, touch AM or PM, 
then touch OK. 
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Paper Jams 

This section includes: 
• Locating Paper Jams ......................................................................................................................................................... 114 
• Clearing Paper Jams ......................................................................................................................................................... 116 
• Minimizing Paper Jams .................................................................................................................................................... 126 
• Troubleshooting Paper Jams ......................................................................................................................................... 128 
• Clearing Staple Jams ........................................................................................................................................................ 129 
 
 

Locating Paper Jams 

The following illustration shows where paper jams can occur along the paper path in the base 
printer configuration. 

 
1. Fuser 
2. Right Side Door 
3. Duplex Unit 

4. Tray 1 
5. Tray 2 
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The following illustration shows where paper jams can occur along the paper path in the printer 
configured with the optional trays and Finisher. 

 
1. 1100-Sheet High-Capacity Feeder 
2. 550-Sheet Feeders 
3. Tray 2 
4. Horizontal Transport Unit 
5. Finisher 

6. Fuser 
7. Right Side Door 
8. Duplex Unit 
9. Tray 1 
10. Optional Feeder Right Side Doors 

 

 CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently 
damage the printer. 
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Clearing Paper Jams 

This section includes: 
• Clearing Misfeeds at Tray 1 ........................................................................................................................................... 116 
• Clearing Misfeed at Tray 2 ............................................................................................................................................ 118 
• Clearing Jams at the Right Side Door ....................................................................................................................... 120 
• Clearing Jams at the Fuser ............................................................................................................................................. 122 
• Clearing Jams at the Finisher ........................................................................................................................................ 124 
• Clearing Jams at the Horizontal Transport Unit ................................................................................................... 125 
 

 CAUTION: To avoid damage, always remove jammed paper carefully, without tearing it. Try to 
remove the paper in the direction that it would normally feed. Any piece of paper left in the printer, 
whether large or small, can obstruct the paper path and cause further jams. Do not reload paper that 
has jammed. 

  

Note: To clear jams, watch the video and follow the instructions on the control panel. 
 

 
 

Clearing Misfeeds at Tray 1 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Remove any paper from Tray 1. 

 
2. Close Tray 1. 
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3. Lift the right side door latch and open the door. 

 
4. Remove any remaining paper jammed in Tray 1. 

 
5. Use the handle to lift the duplex unit. 

 
6. Remove any remaining pieces of paper. 
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7. Close the right side door. 

 
 

Clearing Misfeed at Tray 2 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Remove any paper from Tray 1. 

 
2. Close Tray 1. 

 
3. Lift the right side door latch and open the door. 
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4. Remove any remaining paper jammed in Tray 1. 

 
5. Use the handle to lift the duplex unit. 

 
6. Remove any remaining pieces of paper. 

 
7. Close the right side door. 
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8. Remove Tray 2 from the printer. 

 
 

Note: Reach into the tray and remove any partially fed sheets that may tear or jam the tray. 
 

9. Remove any creased or jammed paper from Tray 2. 

 
 

Note: Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper. 
 

10. Reinsert Tray 2 into the printer. 

 
 

Clearing Jams at the Right Side Door 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
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1. Remove any paper from Tray 1. 

 
2. Close Tray 1. 

 
3. Lift the right side door latch and open the door. 

 
4. Use the handle to lift the duplex unit. 
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5. Remove any paper from the duplex unit. 

 
6. Close the right side door. 

 
 

Clearing Jams at the Fuser 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
 

 WARNING: To avoid burns, do not clear paper jams immediately after printing. The fuser becomes 
hot during use. 

 

1. Remove any paper from Tray 1. 
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2. Close Tray 1. 

 
3. Lift the right side door latch and open the door. 

 
4. Pull out, then press down the tab on the inner cover to hold it open. 

 
5. Remove the jammed paper. 
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6. Release the inner cover. 

 
7. Close the right side door. 

 
 

Clearing Jams at the Finisher 
To resolve the error displayed on the control panel you must clear all paper from the paper path. 

 

Note: Ensure that the cover of the horizontal transport unit is closed before opening the finisher door. 
This procedure does not work properly if the horizontal transport unit is open. 

 

1. Open the front door of the finisher. 
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2. Rotate the knob clockwise and remove the jammed paper from the paper exit. 

 
 

Note: If the paper jam message remains, repeat this step. 
 

3. Close the front door of the finisher. 

 
 

Note: If the paper jam message remains, repeat this step. 

 
 

Clearing Jams at the Horizontal Transport Unit 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Grasp the handle of the horizontal transport unit and open the cover. 
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2. Remove the jammed paper. 

 
3. Close the cover of the horizontal transport unit. 

 
 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox® supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the 
paper path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, see Supported Paper on page 32. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• Fan the paper to separate the sheets before loading it into the tray. 
• Observe the paper tray fill line; never overfill the tray. 
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• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 
can cause poor print quality, misfeeds, skewed prints, and printer damage. 

• After loading the trays, select the correct paper type and size on the control panel. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 
• Use only Xerox® paper and transparencies designed for the printer. 

Avoid the following: 
• Polyester coated paper that is specially designed for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the trays. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, go to www.xerox.com/paper. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=rmlna&Language=English�
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .................................................................................................................................. 128 
• Paper Misfeeds .................................................................................................................................................................... 128 
• Label and Envelope Misfeeds ....................................................................................................................................... 129 
• Paper Jam Message Stays On ....................................................................................................................................... 129 
• Jams During Automatic 2-Sided Printing ................................................................................................................ 129 
 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present. • Try a new ream of paper. 
• Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox®-approved paper. For details, see Supported Paper 
on page 32. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in 
the tray. 

• Remove the misfed paper and reposition it properly in the tray. 
• Adjust the paper guides in the tray to match the size of 

the paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted to 
the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, do 
not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Use paper of the correct size, thickness, 
and type. 

Use only Xerox® approved paper. For details, see Supported Paper on 
page 32. 
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Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in 
the tray. 

Load label sheets according to the instructions from the 
manufacturer. 
• Load labels face down in Tray 1. 
• Load labels face up in Tray 2. 

Envelopes are loaded incorrectly in Tray 1. Load the envelopes in Tray 1 with the flaps closed, flap-side up, and 
the short edge leading into the printer. 

Envelopes are loaded incorrectly in Tray 2. To load envelopes in Tray 2: 
• Load No. 10, Monarch, or DL envelopes with the flaps closed, 

flaps down, and flaps toward the front. 
• Load C5 envelopes with the flaps closed, flaps down, and flaps 

toward the right. 
 
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed all of 
the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
  

Note: Check for, and remove, torn pieces of paper in the paper path. 
 
 

Jams During Automatic 2-Sided Printing 
 

Probable Causes Solutions 

Use paper of the correct size, thickness, 
and type. 

• Use paper of the correct size, thickness, and type. 
• Do not use transparencies, envelopes, labels, reloaded paper, or 

paper heavier than 220 g/m² for automatic 2-sided printing. 

Paper type is set incorrectly in the print driver. Ensure that the paper type is set correctly in the driver and the paper 
is loaded in the correct tray. For details, see Supported Paper Sizes 
and Weights for Automatic 2-Sided Printing on page 34. 

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see 
Supported Paper on page 32. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
 
 

Clearing Staple Jams 

A message appears on the control panel when a staple jam occurs. 
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 WARNING: Do not perform this procedure while the printer is printing. 
 

1. Open the front door of the finisher. 

 
2. Remove the staple cartridge from the printer by pulling it toward you. 

 
 

3. Open the staple cartridge clamp by pulling firmly in the direction shown. 

 
4. Remove the jammed staples (1), then push the clamp in the direction shown until it snaps into the 

locked position (2). 
 

 WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully. 
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5. Insert the staple cartridge into the finisher. 

 
6. Close the front door of the finisher. 
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Print-Quality Problems 

This section includes: 
• Controlling Print Quality .................................................................................................................................................. 132 
• Solving Print-Quality Problems ..................................................................................................................................... 134 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/6700support. 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 

Notes: 

• To ensure consistent print quality, the toner cartridges and imaging units for many models of 
equipment are designed to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

 

 
 

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color 
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal 
print quality is: 15–28ºC (59–82ºF) and 20–70% relative humidity. 
 

Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox® supported paper types and sizes. For details, see Supported Paper on page 32. 
• Use only dry, undamaged paper. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+6700&PgName=tech&Language=english�
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 CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, 
or damage your printer. Do not use the following: 

• Rough or porous paper. 
• Inkjet paper. 
• Non-laser glossy or coated paper. 
• Paper that has been photocopied. 
• Paper that has been folded or wrinkled. 
• Paper with cutouts or perforations. 
• Stapled paper. 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips. 
• Padded envelopes. 
• Plastic media. 

 

• Make sure the paper type selected in your print driver matches the paper type on which you 
are printing. 

• If you have the same size paper loaded in more than one of the trays, make sure that the proper tray 
is selected in the print driver. 

• Store your paper and other media properly for optimum print quality. For details, see Paper Storage 
Guidelines on page 33. 

 

Print-Quality Modes 

Select the correct print-quality setting for your print job from the print driver. For instructions on setting 
the print quality, see Selecting Printing Options on page 53. To control the print quality: 
• Ensure that the print quality is set to the correct mode. For example, if the image does not appear as 

vivid and sharp as you expect, set the print quality to Photo. The default setting is Standard. 
• Use the print-quality settings in the print driver to control print quality. If the print quality is not 

suitable, adjust the print-quality setting to an higher level. 
• Use only Xerox® approved paper. For details, see Supported Paper on page 32. 
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Solving Print-Quality Problems 

Use the following table to find solutions to print-quality problems. 
 

Print-Quality Problems and Solutions 
 

Problem Solution 

Smears, Smudges, and Streaks 
Dark or light marks appear on your 
output. 

 

Run the Fuser Cleaning procedure. At the control panel, touch Printer > 
Tools > Troubleshooting > Resolve Problems > Smears, Smudges, and 
Streaks > Start Cleaning. Several blank pages feed through the printer 
to remove toner accumulated on the fuser. 
If the problem persists, print the test pages to help determine which 
component is causing the image-quality problem. 
• If the defect occurs only in one color, replace the corresponding 

imaging unit. 
• If the defect occurs in all colors and is visible on all the test pages, 

replace the fuser. 

Repeating Spots or Lines 
Spot or lines appear at regular intervals 
on the prints. 

 

1. Print the Repeating Defects page to identify the part of the printer 
causing the problem. At the control panel, touch Printer > Tools > 
Troubleshooting > Resolve Problems > Repeating Spots or Lines > 
Print. 

2. Follow the instructions on the Repeating Defects page to identify the 
part responsible for the repeating spots or lines. 

3. Replace the printer part identified by the Repeating Defects page to 
correct the problem. 

 

Note: Touch the video icon in the top bar to view a video for identifying 
the part causing the repeating defect. 

 

Colors Look Wrong 
Colors are off or look drastically wrong. 

 

1. Verify that the printer is on a solid, level, and flat surface. 
2. Perform the Register Color procedure. At the control panel, touch 

Printer > Tools > Troubleshooting > Resolve Problems > Colors Align 
Incorrectly. 

3. Touch Register Color, then follow the instructions. 
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Problem Solution 

Colors Look Wrong 
Colors are off or look drastically wrong. 

 

1. Verify that the printer is on a solid, level, and flat surface. 
2. Perform the Calibrate Color procedure. At the control panel, touch 

Printer > Tools > Troubleshooting > Resolve Problems > Colors Look 
Wrong > Calibrate Color, then follow the instructions. 

 

Colors Too Light or Too Dark 
The print or color density is too light, 
missing, or the background is foggy. 

 

1. Verify that the paper you are using is the correct type for the printer 
and is loaded properly. For information on supported paper types and 
weights, at the control panel, touch Printer > Print Reference 
Materials > Paper Tips > Print to print the Paper Tips pages. 

2. Verify that the paper loaded in the tray matches the paper type 
selected at the control panel and in the print driver. 

3. Print the Graphics Demo Page. At the control panel, touch Printer > 
Print Reference Material > Graphics Demo > Print. 
If the Demo Page looks correct, the printer is printing properly. Your 
application or incorrect settings in the print driver are probably 
causing the print-quality problems. 

4. If the Demo Page did not print correctly, perform the Calibrate Color 
procedure. At the control panel, touch Printer > Tools > 
Troubleshooting > Resolve Problems > Colors Look Wrong > 
Calibrate Color, then follow the instructions. 

5. Perform the Clean Color Density Sensor procedure. For details, go to 
Cleaning the Density Sensor on page 72. 

 

Note: Touch the video icon in the top bar to view a video demonstrating 
the Clean Color Density Sensor cleaning procedure. 

 

Page Margins Are Inconsistent 
The image is not centered on the page or 
the margins are not consistent. 

 

Use the image position tool to adjust the image position on the page. At 
the control panel, touch Printer > Tools > Troubleshooting > Resolve 
Problems > Page Margins are Inconsistent > Image Position, then 
follow the instructions. 
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Problem Solution 

Sides 1 and 2 Are Not Aligned 
The image is not centered on the page or 
the margins are not consistent. 

 

1. To check alignment, hold your print up to a strong light and look for 
the shadow cast by Side 2. 

2. Perform the Image Position procedure. At the control panel, touch 
Printer > Tools > Troubleshooting > Resolve Problems > Side 1 and 
2 Are Not Aligned. 

3. Touch Image Position, then follow the instructions. 

 

Vertical White Lines or Streaks - One Color 
Lines or streaks appear in one color of 
your output. 

 

1. Print the test pages to identify the affected color. 
2. Use the Laser Window Cleaning Wand, located on the back of the 

front cover, to clean the laser windows of the affected color. 
 

Note: Touch the video icon in the top bar, then touch Clean the Laser 
Window to view a video demonstrating the procedure. 

 

Toner Missing or Easy to Rub Off 
Toner appears to be missing from the 
print or is easy to rub off. 

 

3. Verify that the paper you are using is the correct type for the printer 
and is loaded properly. For information on supported paper types and 
weights, at the control panel, touch Printer > Print Reference 
Materials > Paper Tips > Print to print the Paper Tips pages. 

4. Verify that the fuser envelope lever is set to the correct position. 
5. Select a heavier paper at the control panel. 
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Getting Help 

This section includes: 
• Control Panel Messages .................................................................................................................................................. 137 
• Using the Integrated Troubleshooting Tools ......................................................................................................... 139 
• PhaserSMART Technical Support ................................................................................................................................ 141 
• CentreWare Internet Services....................................................................................................................................... 141 
• More Information .............................................................................................................................................................. 142 

Xerox® provides several automatic diagnostic utilities to help you maintain productivity and print quality. 
 
 

Control Panel Messages 

The printer control panel provides information and troubleshooting help. When an error or warning 
condition occurs, the control panel displays a message informing you of the problem. In many cases, the 
control panel also displays an animated graphic showing the location of the problem, such as the location 
of a paper jam. For many error and status messages, the control panel Help provides additional 
information. 
 

Control Panel Help 

Touch Help to view additional information about items and selections that appear on the control panel. 
The Help button is labeled with a question mark symbol (?). 

 

The control panel menu items also have associated help text that describes the menu item. 
 

Viewing Error Messages on the Control Panel 

When an error or warning condition occurs, a message appears on the control panel to inform you of the 
problem. Error messages warn you about printer conditions, such as low supplies or doors open, that 
require your attention. If more than one error or warning occurs, only one is displayed on the 
control panel. 
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To view a list of the current error messages on the control panel: 
1. At the control panel, touch Printer. 
2. Touch Current Messages. 

A list of the current error messages appears on the screen. 
3. Touch Back to return to the Troubleshooting screen, or touch Home to return to the main screen. 
 

Viewing Current Faults on the Control Panel 

When a fault condition occurs, a message appears on the control panel to inform you of the problem. 
Fault messages warn you about printer conditions that prevent the printer from printing or degrade 
printing performance. If more than one fault occurs, only one is displayed on the control panel. 

To view a list of the current faults on the control panel: 
1. At the control panel, touch Printer. 
2. Touch Current Faults. 

A list of the current faults appears on the screen. 
3. Touch a fault to view the fault details. 
4. Touch X to close the screen. 
5. Touch Back to return to the Troubleshooting screen, or touch Home to return to the main screen. 
 

Viewing the Fault History on the Control Panel 

When faults occur, they are logged in to a fault history file by date, time, and fault code. Use this list to 
identify trends and resolve problems. 

To view the fault history: 
1. At the control panel, touch Printer. 
2. Touch the Tools tab, then touch Troubleshooting. 
3. Touch Fault History. 

The screen displays the number, date, and time for each fault code. 
4. Touch a fault to view the fault details. 
5. Touch Back to return to the Troubleshooting screen, or touch Home to return to the main screen. 
 

Viewing Job Status on the Control Panel 

To view personal and secure jobs on the control panel: 
1. At the control panel, touch Jobs. 
2. Touch Personal and Secure Jobs. 

A list of assigned folders appears. 
3. Touch your assigned private folder. 
4. Do one of the following: 

• Type the passcode assigned to the job, then touch OK. A list of the stored personal and secure 
print jobs appears. 

• Touch Skip Passcode and only show Personal Jobs. A list of your personal jobs appears. 
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5. Touch the job you want to view. 
The screen displays information about the job such as the owner, type, status, and time submitted 
and completed. 
To print the job, see Personal Print on page 65 or Secure Print on page 64. 

6. To return to the main screen, touch Home. 

To view saved jobs on the control panel: 
1. At the control panel, touch Jobs. 
2. Touch Saved Jobs. 

A list of folders appears. 
3. To view public saved jobs, touch Public. 

A list of public saved jobs appears. 
4. To view private saved jobs, touch the assigned private folder. 
5. Type the passcode assigned to the job, then touch OK. 

A list of private saved jobs appears. 
6. Touch the job you want to view. 

The screen displays information about the job such as the owner, type, status, and time submitted 
and completed. 
To print the job, see Saved Job on page 65. 

7. To return to the main screen, touch Home. 

To view completed jobs on the control panel: 
1. At the control panel, touch Jobs. 
2. Touch Completed Jobs. 

The Completed Jobs screen displays the last 50 completed jobs. 
3. Touch the job you want to view. 

The screen displays information about the job such as the owner, type, status, and time submitted 
and completed. 

4. Touch Back to return to the Completed Jobs screen, or touch Home to return to the main screen. 
 

Using the Integrated Troubleshooting Tools 

You can use several integrated tools, such as Information Pages, CentreWare Internet Services, and Job 
Tracker, to troubleshoot print quality and jam problems. 
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Printing Information Pages 
1. At the control panel, touch Printer. 
2. On the Information tab, touch Print Reference Materials. 
3. Touch # to set the quantity. 
4. Use the keypad or touch + or - to select the number of copies to print. 
5. Touch OK. 
6. Use the Up or Down Arrow to scroll through the list as needed, and touch the page you want to print. 
7. Touch Print. 
 

Note: Information pages can also be printed from CentreWare Internet Services. 
 
 

Specifying the Source Tray for Printing Information Pages 
1. At the control panel, touch Printer. 
2. Touch the Tools tab, then touch Tray Management. 
3. Touch Information Pages Source. 
4. Touch the specific tray you want the printer to use, or touch Automatic. 
5. Touch OK to confirm the setting. 
6. Touch Back to return to the Tools tab, or touch Home to return to the main screen. 
 

Printing the Configuration Report 
1. At the control panel, touch Printer. 
2. On the Information tab, touch Print Reference Materials. 
3. Touch Configuration Report. 
4. Touch Print. 
 

Note: By default, the Configuration Report prints each time the printer is turned on. To turn off this 
setting, select Printer > Tools > Setup > General Settings > Startup Page > Off. 

 
 

Viewing Billing and Usage Information 
1. At the control panel, touch Printer. 
2. On the Information tab, touch Billing Meters to see basic impression counts: 

• Color impressions: Number of pages printed that specify color. 
• Black impressions: Number of pages printed with no color specified. 
• Total impressions: Total number of color impressions plus black impressions. 

 

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed 
on two sides counts as two impressions. 

 

3. Touch Usage Counters to see detailed usage information. 
 



Troubleshooting 

 

 Phaser 6700 Color Printer 141 
 User Guide 
 

Locating the Serial Number on the Control Panel 
1. At the control panel, touch Printer. 
2. On the Information tab, touch About This Printer. 

The General tab displays the model, serial number, version, and activation date. 
 

Viewing Printer Supply Status 
1. To view the Supplies tab, do one of the following: 

• At the control panel, touch the Printer button, then touch the Supplies tab. 
• Touch one of the C, M, Y, K icons in the lower right of the main screen. 

2. To view details about a toner cartridge, including the part number for reordering, touch C, M, Y, or K. 
3. Touch Close to return to the Supplies tab. 
4. To view details about the fuser, waste cartridge, imaging units, maintenance kit, or staple cartridge, 

touch Other Supplies. Use the Up or Down Arrow to scroll through the list, then select the details you 
want to view. 

5. Touch the Back arrow to return to the Other Supplies screen. 
6. To print the Supplies Usage page, touch the Print icon, then touch Supplies Usage. 
7. To return to the main screen, touch Home. 
 

PhaserSMART Technical Support 

PhaserSMART is an automated, Internet-based system that uses your Web browser to send diagnostic 
information from your printer to the Xerox® website. PhaserSMART examines the information, diagnoses 
the problem, and proposes a solution. 

To access PhaserSMART Technical Support: 
1. Open your Web browser and go to www.phaserSMART.com. 
2. Enter the IP address of your printer in the form fields. 
3. Follow the onscreen instructions. 

To access PhaserSMART Technical Support from Job Tracker: 
1. On the Device tab, click the PhaserSMART button at the bottom of the window. 
2. Follow the onscreen instructions. 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a 
Web browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, or UNIX 

environments. 
• TCP/IP and HTTP enabled in the printer. 

http://www.phasersmart.com/�
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• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 

To access CentreWare Internet Services: 

At your computer, open a Web browser, type the IP address of the printer in the address field, then press 
Enter or Return.  

If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 20. 

To access CentreWare Internet Services from Job Tracker: 

From the Job Tracker Menu, click Help, then select CentreWare Internet Services. 
 

More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with printer 

Quick Use Guide Packaged with printer 

System Administrator Guide www.xerox.com/office/6700docs  

Video Tutorials Available on the printer control panel and at 
www.xerox.com/office/6700docs  

Recommended Media List United States: www.xerox.com/paper  
Europe: www.xerox.com/europaper  

PhaserSMART Technical Support automatically 
diagnoses problems on your network printer and 
proposes solutions. 

www.phasersmart.com  

Technical support information for your printer includes 
online Technical Support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/6700support  

Information about menus or error messages Control panel Help (?) button 

Information pages Print from the control panel menu 

Order supplies for your printer www.xerox.com/office/6700supplies  

A resource for tools and information, such as interactive 
tutorials, printing templates, helpful tips, and customized 
features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=userdocpdfs&FileName=sys_admin_guide&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+6700&PgName=Man&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=rmlna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=rmleu&Language=English�
http://www.phasersmart.com/�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+6700&PgName=tech&Language=english�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=order&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=customersupport&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=reg&Language=English�
http://www.direct.xerox.com/�
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Printer Configurations and Options 

Standard Features 

The Phaser 6700 Color Printer provides the following features: 
• Print at 2400 x 1200 dpi resolution 
• Laser imaging quality 
• Print document sizes up to Legal (216 x 356 mm, 8.5 x 14 in.) 
• Automatic 2-sided printing (except Phaser 6700N printer) 
• Color touch screen control panel 
• Tray 1 with 150-sheet capacity 
• Tray 2 with 550-sheet capacity 
• 1 GB RAM 
• Universal Serial Bus (USB 2.0) 
• Ethernet 10/100/1000Base-T 
• PostScript and PCL fonts 
• PostScript, PCL, and XPS support 
• Data Security 
• GreenPrint software 
• CentreWare Internet Services 
• CentreWare Web 
• Remote driver installation 
• WebJet Admin Interface 
• Tivoli 
• Rendezvous (Bonjour), SLP, SSDP, and SAP device discovery 
• Email Alerts 
• Automated Supplies Replenishment 
• Proactive Supplies Management 
 

Available Configurations 
 

Standard Features by Printer Configuration 

Features 6700N 6700DN 6700DT 6700DX 

Standard memory 1 GB RAM 1 GB RAM 1 GB RAM 1 GB RAM 

Internal 160 GB hard drive Optional Optional Optional Yes 

Automatic 2-sided printing No Yes Yes Yes 

Standard trays 2 2 3 4 
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Optional trays Up to 4 Up to 4 Up to 3 Up to 2 
 
 

Options and Upgrades 
• Finisher with a maximum capacity of 1000 offset and stacked sheets, and a stapler with a maximum 

capacity of 50 sheets per set 
• 1100-Sheet High-Capacity Feeder, consisting of two 550-sheet trays permanently fastened to a base 

with lockable front wheels and anti-tip outriggers 
• 550-Sheet Feeder with one universal adjustable tray 
• Stand, adjustable to 220 mm (8.7 in.) or 295 mm (11.6 in.) height 
• 2 GB optional memory (1 GB additional memory) 
• Productivity Kit with 160 GB hard drive 
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Physical Specifications 

Phaser 6700N/DN Printer Configurations 
• Width: 570 mm (22.4 in.) 
• Depth: 516 mm (20.3 in.) 
• Height: 429 mm (16.9 in.) 
• Weight: 42.2 kg (93 lb.) 
 

Phaser 6700DT Printer Configurations 
• Width: 570 mm (22.4 in.) 
• Depth: 516 mm (20.3 in.) 
• Height: 563 mm (22.1 in.) 
• Weight: 53.2 kg (117 lb.) 
 

Phaser 6700DX Printer Configurations 
• Width: 570 mm (22.4 in.) 
• Depth: 516 mm (20.3 in.) 
• Height: 697 mm (27.4 in.) 
• Weight: 64.2 kg (141.2 lb.) 
 

Printer Configurations With Finisher 
• Width: 1068 mm (42 in.) 
• Depth: 516 mm (20.3 in.) 
• Height: 

525 mm (20.7 in.) with Phaser 6700N/DN Printer 
563 mm (22.2 in.) with Phaser 6700DT Printer 
697 mm (27.4 in.) with Phaser 6700DX Printer 

• Weight: 
57.9 kg (127.6 lb.) with Phaser 6700N/DN Printer 
68.9 kg (151.6 lb.) with Phaser 6700DT Printer 
79.9 kg (175.8 lb.) with Phaser 6700DX Printer 
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Clearance Requirements 

Phaser 6700 Color Printer 
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Phaser 6700 Color Printer With Finisher 
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Environmental Specifications 

Temperature 
• 15°–32°C 
• 59°–90°F 
 

Relative Humidity 

Operating: 15–80% (non-condensing) 
 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 
 

Power Supply Voltage Power Supply Frequency 

110–127 VAC +/-10%, (99–140 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

220–240 VAC +/-10%, (198–264 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

 
 

Power Consumption 
 

Printing Ready Low Power (Standby) Energy Saver Sleep 

Less than 700 W Less than 125 W Less than 75 W Less than 8 W 
 
 

ENERGY STAR Qualified Product 

ENERGY STAR qualified printer (excluding Phaser 6700N Color Printer). 

Default times: 
• Low Power in 15 minutes 
• Sleep in 45 minutes 
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Performance Specifications 

Printing Resolution 

Maximum resolution: 2400 x 1200 dpi 
• Standard print-quality mode: 1200 x 600 dpi 
• Photo print-quality mode: 2400 x 1200 dpi 
 

Note: The print resolutions are indicated for PostScript print drivers only. The only print resolution for 
PCL is 600 x 600 dpi. 

 
 

Print Speed 

Print speeds in pages per minute (ppm) are provided for continuous printing on A4 and Letter-sized paper. 
Print speeds are the same for color or black and white printing. 
  

1-Sided Printing Print Quality: Standard Print Quality: Photo 

 A4 Letter A4 Letter 

Plain, Hole Punched, Pre-Printed, Letterhead, 
Recycled, Custom 

45 ppm 47 ppm 23 ppm 24 ppm 

Cardstock, Heavyweight Cardstock, Glossy 
Cardstock, Heavyweight Glossy Cardstock 

23 ppm 24 ppm 23 ppm 24 ppm 

Labels 23 ppm 24 ppm 23 ppm 24 ppm 

Envelope 15 ppm 16 ppm 15 ppm 16 ppm 

Transparency 8 ppm 8 ppm 8 ppm 8 ppm 

  

2-Sided Printing Print Quality: Standard Print Quality: Photo 

 A4 Letter A4 Letter 

Plain, Hole Punched, Pre-Printed, Letterhead, 
Recycled, Custom 

36 ppm 38 ppm 18 ppm 19 ppm 

Cardstock, Heavyweight Cardstock, Glossy 
Cardstock, Heavyweight Glossy Cardstock 

18 ppm 19 ppm 18 ppm 19 ppm 
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Controller Specifications 

Processor 

1.25 GHz processor 
 

Memory 
• Standard memory: 1 GB RAM 
• Maximum memory: 2 GB RAM (1 GB additional memory) 
 

Interfaces 
• Ethernet 10/100/1000Base-T 
• Universal Serial Bus (USB 2.0) 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these 
instructions, it may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
 

European Union 
 

 CAUTION: This is a Class A product. In a domestic environment, this product can cause radio 
interference in which case the user could be required to take adequate measures. 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 
• December 12, 2006: Low Voltage Directive 2006/95/EC 
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• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds  
• European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=msdsna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=environmenteu&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=customersupport&Language=English�
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All Countries 

If you are managing the disposal of your Xerox® product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate�
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox® product is part of the program. For more information 
about Xerox® environmental programs, visit www.xerox.com/environment , or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+6700&PgName=environmentna&Language=English�
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment 
to designated collection facilities free of charge. Please contact your local disposal authority 
for information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that 
you must dispose of this equipment in compliance with agreed 
national procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life 
take-back information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents mean 
that used electrical and electronic products and batteries should not be 
mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 2002/96/EC 
and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Note for the Battery Symbol 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a MANUFACTURER-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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